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Appendix

Conversion Factors—English to Metric

To convert from To Multiply by

in mm   25.4

ft m     0.3048

kip/in2 (ksi) MPa (N/mm2)     6.895

kip kN     4.448

kip-ft kN-m     1.356

lb/ft kg/m     1.488164



A-2 Appendix

          PCACOL

Conversion Factors—Metric to English

To convert from To Divide by

mm in 25.4
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Chapter 1
Introduction

Terms
The following terms are used throughout this manual. A brief explanation is given to
help familiarize yourself with them.

Windows refers to the Microsoft Windows environment version 3.1 or
higher.

[ ] indicates metric equivalent

Click on means to position the cursor on top of a designated item or
location and press and release the left-mouse button (unless
instructed to use the right-mouse button).

Double-click on means to position the cursor on top of a designated item or
location and press and release the left-mouse button twice in
quick succession.
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Conventions

To help you locate and interpret information easily, the PCACOL manual adheres to
the following text format.

Style Meaning

Italic indicates a glossary item, or emphasizes a given word
or phrase.

Bold indicates the name of a menu or a menu item command
such as File or Save.

Mono-space indicates something you should enter with the keyboard.
For example “c:\*.txt”.

KEY + KEY indicates a key combination. The plus sign indicates
that you should press and hold the first key while press-
ing the second key, then release both keys. For example,
“ALT + F” indicates that you should press the “ALT”
key and hold it while you press the “F” key. then
release both keys.
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System Requirements

To use PCACOL, a personal computer running Microsoft Windows V3.1 is required.
PCACOL needs less than 1.0 MB of disk space to install.

Program Capacity

• 500 reinforcing bars within a section.

• 50 exterior points that define the geometric outline of the cross section
(IRRCOL module only).

• 50 interior points that define an opening in the cross section (IRRCOL
module only).

• 160 factored load entries, each consisting of an axial load, a moment
about the x-axis, and a moment about the y-axis.

• 10 service load entries, each consisting of dead, live, and lateral axial
loads, moments at column top about the x and y axes, and moments at
column bottom about the x and y axes.
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Installing PCACOL

1. Execute Windows and insert the PCACOL diskette into the proper floppy disk
drive.

2. From the Program Manager File menu, selct Run.

3. Enter a:pcasetup or b:pcasetup (depending on the drive the diskette is
in) in the Command Line text box, then choose ok.

4. Follow the instructions displayed on the screen.

5. After the setup program displays a successful installation message, the lst dialog
box displayed asks whether you would like to view the README.TXT file. This
file contains information supllemental to the manual.

Running PCACOL

Select the “PCACOL” icon from within the “PCA Programs” group window and
press ENTER (or simply double-click on the icon).

1-4
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 Method of Solution

PCACOL enables the user to compute the capacity of (investigate) or design reinforced
concrete column sections. The section under consideration may be subject to a
combination of loadings consisting of combined axial loads and uniaxial or biaxial
moments.

In PCACOL, the section may be rectangular or circular with any reinforcement layout.
Material properties for the concrete and reinforcing steel are user-controlled. The
applied loading consists of tensile or compressive axial loads acting alone or combined
with uniaxial or biaxial bending.

At the user’s option, the program may investigate the slenderness effects on a column
using the approximate method described in the design code. If applicable, the program
computes the magnification factors to be applied to the moment(s).

With the IRRCOL add-on module, PCACOL can investigate irregularly-shaped
sections. An irregular section is defined as a closed polygon and may even contain an
opening (hollow section).

PCACOL conforms to the provisions of the following desing specifications:
Building Code Requirements for Structural Concrete (ACI 318-95), published by the
American Concrete Institute, Farmington Hills, MI.

Design of Concrete Structures (A23.3-94), published by the Canadian Standards
Association, Ontario, Canada
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A - Definitions and Assumptions

1. The analysis of the reinforced concrete section conforms to the provisions of the
Strength Design Theory.
a) All conditions of strength satisfy the applicable conditions of equilibrium

and strain compatibility.
b) Strain in the concrete and in the reinforcement is directly proportional to

the distance from the neutral axis.
c) The maximum usable (ultimate) strain at the extreme concrete compression

fiber is assumed equal to 0.003 (0.0035 for CSA) unless otherwise specified
by the user.

d) A uniform rectangular concrete stress block is used. The maximum uni-

form concrete compressive stress, fc, is 0.85 ′ f c   and the block depth is β1c,
where c is the distance from the extreme compression fiber to the neutral
axis and β1 is described in item 4 below. Both fc and β1 may be
modified by the user. For CSA, fc  is taken as:

 fc = (0.85 – 0.0025 ′ f c ) ′ f c  ≥ 0.67 ′ f c , where e ′ f c  is in MPaa
e) Concrete displaced by the reinforcement in compression is deducted from

the compression block.

2-2

Figure 2-1 — Analysis of Reinforced Concrete Section
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f) For the reinforcing steel, the elastic-plastic stress-strain distribution is used.
Stress in the reinforcing steel below the yield strength, fy, is directly
proportional to the strain. For strains greater than that corresponding to the
yield strength, the reinforcement stress remains constant and equal to fy. If
the rupture strain for steel is specified, for strains greater than the
specified rupture strain, the reinforcement stress equals zero.

g) Tensile strength of concrete is neglected.

2. The modulus of elasticity of concrete, Ec, is computed as follows (unless
otherwise specified by the user):

Ec = 57,000         where ′ f c and Ec are in psi.

Ec = 4,700          where     and Ec are in MPa.

For the CSA standard, Ec = 4,500 ′ f c , where ′ f c  and Ec are in MPa.a.

Figure 2-2 — Elastic-Plastic Stress-Strain Reinforcement Curve
a) with εrupture = infinity, b) εrupture specified
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3. The modulus of elasticity of reinforcing steel, Es, is taken as 29,000 ksi unless
otherwise specified by the user.

4. The ratio of the concrete compression block depth to the distance between the
extreme compression fiber and the neutral axis, β1, is computed as follows (unless
otherwise specified by the user):

0.65 ≤ β1 = 1.05 – 0.05 ′ f c  ≤ 0.85, where ′ f c  is in ksi

0.65 ≤ β1= 1.0643 – 0.007143 ′ f c  ≤ 0.85, where ′ f c  is in MPaa

For CSA: β1 = 0.97 – 0.0025 ′ f c  ≥ 0.67, where ′ f c  is in MPaa

5. Stress in the reinforcement is computed based on the strain at the centroid of
each reinforcing bar.

6. All moments are referenced to the geometric centroid of the gross concrete section
(neglecting the reinforcement).

7. For the ACI code, the nominal (unreduced) strength of the section is first computed
on the basis of the strength of materials. This is then reduced to the design strength
using the capacity reduction factors.

The following reduction factors are used for the ACI code:
φa is the reduction factor for pure axial compression
φb is the reduction factor for flexure and axial tension
φc is the reduction factor for flexure and axial compression

For compressive design axial loads less than the smaller of 0.1 ′ f cAg and
the balanced load, the program interpolates between φc and φb.

For the CSA standard, the following factors are used:
φs is the reduction factor for pure axial compression
φb is the material resistance factor for steel

2-4
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φc is the material resistance factor for concrete
8. If the reinforcement ratio falls below the code-specified minimum of 1%,

the program has two options: consider the section as Structural or
Architectural . For Architectural, the maximum concrete stress, fc, is
multiplied by the reinforcement ratio. This produces the same effect as
reducing the concrete area to achieve a reinforcement ratio of 1%.
For Structural, the specified concrete stress is used.

9. Under the Design option, the reinforcement ratio cannot be less than 0.5%.
Under the Investigation option, any value can be used for the reinforcement
ratio.

2-5

                

               

 

 

  

    

      

  

        
  

       

           

           

Figure 2-3 — Reduction Factors for Flexure and Axial Load per ACI code
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B - Sign Convention

1. Looking at the section in plan, the positive x-axis points to the right and the
positive y-axis points up.

2. Positive axial loads are compressive and negative axial loads are tensile.

3. The right-hand rule is used to determine the compression and tension faces of
the section. A positive moment about the x-axis, Mx, produces tension at the top
face of the section and compression at the bottom face. A positive moment about
the y-axis, My, produces tension at the left face of the section and compression
at the right face.

4. If service loads are input, moments at the upper (top) and lower (bottom) ends of
the column are needed. Top and bottom moments of opposite signs produce
single curvature bending. Top and bottom moments of the same sign produce
double curvature bending.

In the global coordinate system, the section at the upper end of the column
coincides with PCACOL’s local coordinate system where positive moments about
the y-axis produce tension on the left side of the section. However, the global
coordinate system produces an opposite effect on the section at the lower end of
the column where positive moments about the y-axis produce tension on the
right side of the section. Since PCACOL assumes the reinforcement pattern to
be constant throughout the column height, the program internally changes the
sign of the service moments at the lower end to convert from the global coordinate
system to the local.

5. For uniaxial runs, the factored moments considered always produce positive
bending on the section as described in item 3 above. This is valid for the cases
when the section is symmetrical about the run axis. If the column bends in double
curvature and the section is not symmetrical, a biaxial investigation run is
recommended.
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Figure 2-4 — PCACOL’s positive local coordinate system

Figure 2-5 — PCACOL’s positive global system
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C - Section Investigation

1. The computations performed when investigating a section depend on the selected
load mode:
a) Factored loads - for the axial load of each load point, the moment capacity

and the ratio of design-to-applied moment are computed. For a biaxial run,
the computed Mx and My moment capacities are at the same angle as that
produced by the applied Mx and My moments.

b) Service loads - the program computes the factored loads using the input
load combinations. If slenderness effects are to be checked and the column
is found to be slender, the applied moments are magnified according to
Procedures E and F. For each factored load, the same computations
described in (a) above are performed.

c) Control points - for several key points on the interaction diagram, the axial
load, corresponding moment capacity and the corresponding neutral axis
depth are computed. The key points are: pure compression, maximum
compression, point where steel stress is zero, point where steel stress is
0.5 fy, balanced point, pure flexure and pure tension.

d) Axial loads – for each input axial load, the moment capacity and the corre-
sponding neutral axis depth are computed.

2. The program also computes the interaction diagram (uniaxial runs) or the three-
dimensional failure surface (biaxial runs) of the input section. The values of
pure compressive axial load capacity and pure tensile axial load capacity are
computed. These two values set the range within which the moment capacities
are computed. A predetermined number of axial load values (within this range)
are computed.
a) For uniaxial runs, the moment capacity about the selected axis only is

computed. The moment capacity about the orthogonal axis is ignored. To
compute the moment capacity at a certain level of axial load, the neutral
axis angle is held constant, parallel to the selected axis. The neutral axis
depth is adjusted to arrive at the desired axial load capacity. This is done for
all the predetermined values of axial load.
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b) For biaxial runs, the same predetermined values of axial load are utilized.
For each level of axial load, the section is rotated in 10-degree increments
from 0 degrees to 360 degrees and the Mx and My moment capacities are
computed. Thus for each level of axial load, an Mx-My contour is
developed. Repeating this for the entire range of axial loads, the three-
dimensional failure surface is computed.

2-9
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Figure 2-6— Interaction Surface for Combined Axial Load and Biaxial Bending
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D- Section Design

1. Based on the specified minimum, maximum and increment specified for the
section and the reinforcing bars, the program selects the smallest section with
the least amount of reinforcement for which the load-moment capacity exceeds
the applied loads. If service loads are input, they are factored using the input
load combinations.

2. The program starts the design by trying the smallest section (minimum dimensions)
and the least amount of reinforcing bars (smallest bar size and minimum number
of bars). The program verifies that the ratio of provided reinforcement is always
within the specified minimum and maximum ratios. Furthermore, the bar spacing
is always kept greater than or equal to the larger of 1.5 times the bar diameter or
1.5 in. [40 mm] (unless otherwise specified by the user).

3. A section fails the design if, for the design axial load, the ratio of design-to-
applied moment is less than 1.0(unless otherwise specified in the Design Criteria
box).

4. Once a section passes the design, its capacity is computed and the computations
explained in Procedure C above are performed.

2-11
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E - Moment Magnification (Slenderness Effects) for Braced Columns

1. If properties of framing members are input, PCACOL computes the braced
condition effective length factor, kb, as the smaller of:

0.7 + 0.05 (ψA + ψB)
0.85 + 0.05 ψmin

Where ψ  is the ratio of Σ(EI/L) of columns to Σ(EI/L) of beams in a plane at one
end of the column, ψA andψB are the values of ψ at the upper end and the lower
end of the column, respectively, and ψmin is the smaller of ψA and ψB.

The value of kb must always be between 0.5 and 1.0. The moment of inertia used
in computing ψ is the gross moment of inertia multiplied by the cracked section
coefficients (specified in the Slenderness Factors box).

2. The smaller and larger factored column end moments M1 and M2, respectively,
are computed. M1 is positive if the column is bent in single curvature and is
negative if the column is bent in double curvature. M2 is always positive.

3. For the ACI code, slenderness effects will be considered if

kb u

r
≥ 34 −12

M1

M2

For the CSA standard,

 
kb u

r
≥

25− 10M1 / M2

Pf /( ′ f cAg )

where u is the unsupported column length and r is the radius of gyration (r =
Ig

A
).

The ratio M1/M2 is always greater than or equal to -0.5.



PCACOL

Method of Solution

4. If the ratio kb u / r  exceeds 100, slenderness effects using this approximate
procedure cannot be applied. A more exact method must be used. In this case,
the procedure is aborted and a message is issued.

5. The factor Cm is computed as:

Cm = 0.6 + 0.4 
M1

M2

 ≥ 0.4

6. The factor βd is computed as the ratio of maximum factored axial dead load to
the total factored axial load for the load combination under consideration.

7. The quantity (0.2 EcIg + EsIse) is determined; where Ec is the modulus elasticity
of concrete, Es is the modulus elasticity of steel, Ig is the gross moment of inertia
of the concrete section, and Ise is the moment of inertia of reinforcement. The
product EI is computed as:

EI =
0.2EcIg + Es Is e

1 +βd

8. The critical buckling load, Pc, is computed as:

Pc =
π2EI

(kb u)2

2-13
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9. The braced (non-sway) moment magnification factor, δb, is computed as:

δb = 
Cm

1 − Pu

kPc

 ≥ 1.0

where the stiffness reduction factor, φk, is taken as 0.75 (may be modified using
the Slenderness Factors box) and Pu is the factored axial load for the load
combination under consideration.

10. The moment due to minimum eccentricity, emin, is computed as:

emin = 0.6 + 0.03h, where h is in in.
emin = 15 + 0.03h, where h is in mm.

where h is the section dimension (diameter for circular sections) in the direction
being considered. The moment due to the minimum eccentricity is Mmin = Pu emin.

11. The magnified moment, Mc is the larger of δbM2 or δbMmin.
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F- Moment Magnification (Slenderness Effects) for Sway Column

1. If properties of framing members are input, PCACOL computes the sway
(unbraced) condition effective length factor, ks, using the following simplified
equations:

If both ends are restrained and ψm < 2, ks = 0.05(20 - ψm) 1 + m  ≥ 1.0

If both ends are restrained and ψm ≥ 2, ks = 0.9 1 + m  ≥ 1.0

If the upper end is hinged, ks = 2 + 0.3ψB

If the lower end is hinged, ks = 2 + 0.3ψA

If both ends are hinged, ks = 30

Where ψ  is the ratio of Σ(EI/L) of columns to Σ(EI/L) of beams in a plane at one
end of the column, ψA and ψB are the values of ψ at the upper end and the lower
end of the column, respectively, and ψm is the average of ψA and ψB.

An end is determined to be hinged if its ψ is very large. This happens in the case
where Σ(EI/L) of beams is too small (or zero) relative to the Σ(EI/L) of columns
at that end. In this case, the program outputs 999.9 for the value of ψ. The moment
of inertia used in computing ψ is the gross moment of inertia multiplied by the
cracked section coefficients (specified in the Slenderness Factors box).

2. The smaller and larger factored braced (non-sway) column end moments M1b

and M2b, respectively, are computed. These are factored moments due to dead
and live loads. M1b is positive if the column is bent in single curvature and is
negative if the column is bent in double curvature. M2b is always positive.

2-15
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3. The smaller and larger factored sway column end moments M1s and M2s,
respectively, are computed. These are factored moments due to lateral loads.
M1s is positive if the column is bent in single curvature and is negative if the
column is bent in double curvature. M2s is always positive.

4. For the ACI code, slenderness effects will be considered if ks u / r  ≥ 22.0. For
the CSA standard, all sway columns are designed for slenderness effects.

5. If the ratio ks u / r  exceeds 100, slenderness effects using this approximate
procedure cannot be applied. A more exact method must be used. In this case,
the procedure is aborted and a message is issued.

6. The quantity (0.2 EcIg + EsIse) is determined; where Ec is the modulus elasticity
of concrete, Es is the modulus elasticity of steel, Ig is the gross moment of inertia
of the concrete section, and Ise is the moment of inertia of reinforcement. The
product EI is computed as:

EI = 0.2 EcIg + EsIse

7. The critical buckling load, Pc, is computed as:

8. The sway moment magnification factor, δs, is computed as:

δs = 
1.0

1 −
ΣPu

k ΣPc

 ≥ 1.0

where the stiffness reduction factor, φk, is taken as 0.75.

Pc =
2EI

(ks u)2
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ΣPu is taken as the factored axial load for the load combination under
consideration times the ratio ΣPu/Pu.

ΣPc is taken as the critical buckling load for the load combination under
consideration times the ratio ΣPc/Pc.

φk and the ratios ΣPu/Pu and ΣPc/Pc may be modified using the Slenderness
Factors box.

9. If u

r
≤

35

P
u

′ f 
c

A
g

, the magnified moment is computed as:

M1c = M1b + δsM1s

M2c = M2b + δsM2s

10. If u
r

>
35

Pu
′ f c Ag

, the braced moment magnification factor,  δb, is computed

according to steps 1 through 9 as described in Procedure D above. In step 7,
however, βd is computed for the load combination under consideration. The
magnified moment is computed as:

M1c = δb (M1b + δsM1s)

M2c = δb (M2b + δsM2s)

2-17
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G- Output Notation

The following table explains some of the notations used in the output of the program:

Notation ACI code CSA standard

Pu Ultimate factored axial load (Pu) Factored axial load (P f)
Mu Ultimate factored moment (Mu) Factored moment (M f)
fMn Moment capacity (φMn) Factored moment of resistance (Mr)



Chapter 3
The PCACOL Window

Most windows have certain elements in common, such as a title bar and menus. Not all
windows, however, have very element. To learn more about how to use window elements,
refer to your Microsoft Windows manual. The following is a list of the PCACOL window
components.
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Control-Menu Box;
The Control-menu box is located in the upper-left corner of the window and includes
commands for sizing, moving, enlarging, restoring, and closing the window, as well
as switching to other applications. To access the Control-menu box using the mouse,
click the left mouse button on the box; using the keyboard, press ALT+ - (hyphen).

Title Bar:
The Title bar displays the name of the application (PCACOL in this case), along with
the name of the current data file in use. If the data have not been saved into a file, the
word Untitled is displayed in the Title bar.

Menu Bar:
The Menu bar is located directly below the Title bar. It lists the available menus. A
menu contains a list of commands or actions you can execute.

Tool Bar:
The Tool bar is located directly below the Menu bar. It contains a collection of buttons
(or icons) that provide a shortcut to accessing the menu commands. The Tool bar buttons
can only be accessed using the mouse.

Information Bar:
The Information bar is located on the left side of the PCACOL window. The top part
displays the column cross section. The bottom part is a list of selected input data echo.

Graphics Area:
The Graphics area covers most of the window. This is where the interaction diagram
is shown.

Status Bar:
The Status bar is located along the bottom of the window. It displays important
information such as units, design code, cursor position, and helpful messages.
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Using the Menus

To access a menu item using the mouse, point to the menu item and click the left-
mouse button. Each menu item can also be selected with the keyboard by simultaneously
pressing the ALT key and the underlined letter of the menu you want to open. For
example, to open the File menu, press ALT + F.

To close a menu without selecting a command, point to any blank area on the screen
and click the left-mouse button, or press ESC.

To choose a command from a selected menu, point to that command and click the left-
mouse button, or use the UP and DOWN ARROW keys until you reach the command
and press ENTER.

Menu Conventions

The following menu conventions are used in PCACOL.

Menu Convention Meaning

Dimmed (or not visible) command. The command is not available at the
current time.

An ellipsis (…) following a command. When the command is selected, a
dialog box will appear, requesting
data input or listing options to select
from..

A check mark (✔) next to a command. The command is in effect. When the
check mark is removed (by selecting
the command), the command is no
longer in effect.
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Using a Dialog Box

A dialog box is displayed to request information or to supply you with information. An
ellipsis (…) after a menu command indicates a dialog box will appear when that
command is elected. For example, if you choose the Open command from the File
menu, the OPEN dialog box appears. In this dialog box, specify the name of the file you
want to open.
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Command Button:
The Command button (or Push button) is labeled to do exactly what it says. The OK and
CANCEL buttons are common command buttons. A command button followed by an
ellipsis (…) opens another dialog box. The currently selected button has a darker border
than other buttons. You can choose the selected button by pressing ENTER.

Option Button:
The Option button (or Radio button) is one of a group of related options in which you
can select only one. When an option is selected, the selected option button contains a
black dot. To select an option with the mouse, click the mouse button on the option you
want, or using the keyboard, press TAB to move to the group of options you want and
use the arrow keys to select the option button.

Check Box:
The Check box is an option that can be turned on or off. Unlike option buttons, you can
turn on as many check boxes as you want, even if they are in a group. When a check box
is turned on, an “X” appears in the box. If you are using a mouse, click a blank check
box to select it or click a selected check box to clear it. If you are using a keyboard,
press TAB to move to the check box. Press the SPACEBAR to select the box. Press the
SPACEBAR again to clear the selection.

Text Box:
The Text box is where data or information are entered. When you move into an empty
text box, an insertion point (flashing vertical bar) appears. The text you type starts at
the insertion point. If the box already contains text, it is selected and any text typed
replaces it. You can also delete the existing text by pressing DEL or BACKSPACE.

List Box:
A List box displays a list of choices. If there are more choices than can fit in the box,
scroll bars are provided so you can move quickly through the list. To select an item
from a list box, click the scroll arrows until the item you want to select appears in the
list box, then click on that item. If you are using the keyboard, use the arrow keys to
scroll to the item you want.
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Drop-Down List:
A Drop-down list appears initially as a rectangular box with the current selection marked.
To see a list of available choices, click the arrow at the right of the box or press ALT +
DOWN ARROW to open the box. You can now select another item by scrolling as you
do with a list box.

The PCACOL Window3-6
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Working with a List Box

A list box displays a list of choices or items. If there are more choices than can fit in the
box, scroll bars are provided. The scroll bar is usually located to the right (vertical
scroll bar) or at the bottom (horizontal scroll bar) of a list box.

To select  a single item from a list box:

• Click the scroll arrows until the item you want to select appears in the list box.
Click the item.

• Using the keyboard, use the UP or DOWN arrow key to scroll to the item you
want.

To select  multiple sequential items in a list:

• Click the first item you want to select and then drag the cursor to the last item you
want to select. Alternatively, click on the last item you want to select. Both items,
and all items in between, are selected. To cancel the selections, release the SHIFT
key and click any item.

• Using the keyboard, use the UP ARROW or DOWN ARROW  key to move the
cursor to the first item you want to select. Press and hold down the SHIFT key.
Continue to press the arrow key repeatedly until all the items you want are selected.
To cancel the selections, release the SHIFT key and press one of the arrow keys..

To select  multiple nonsequential items in a list:

• Press and hold down the CTRL key, and click each item you want to select. To
cancel a selection, press and hold down the CTRL key, and click the item again.
There are no keyboard equivalents for this procedure.
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File Menu

The File menu is used for working with data files, printing results, and exiting the
program.

New
Clears any input data and returns the data to the default values so that a new data
file may be input.

Open
Opens an existing PCACOL data file.

Save
Saves the changes you have made to the current data file under that same filename.

Save As
Names or renames a data file.

Import
Reads geometry, reinforcement or loads data from an ASCII (Text) file.

Revert
Discards any changes to the data and returns to the last version of saved data. This
option will only be available if the file has been modified since the last file save.

Print
Prints the results file and displayed curve and cross-section.

Exit
Quits the PCACOL program. If you have made any changes to your data and have
not saved them, PCACOL will prompt you whether you want to save or abandon
any changes you’ve made before you exit.

3-8
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Input Menu

The Input menu includes commands used to input the data needed to define a
problem.

General Information
Input labels to identify the input and select from several options that control the
run.

Material Properties
Input the material properties for concrete and reinforcement.

Section
Rectangular: Input the dimensions of a rectangular section.
Circular: Input the dimension of a circular section.
Irregular: Execute IRRCOL to define an irregularly shaped section.
Requires IRRCOL. See Chapter 7.

Reinforcement
All Sides Equal: Input a reinforcement pattern in which all the bars are of one
size, and the number of bars is the same on all four sides of a rectangular layout or
are equally spaced for a circular layout. Available for rectangular and circular
sections.
Equal Spacing: Input a reinforcement pattern in which all bars are of one size and
are uniformly spaced on all four sides of a rectangular layout. Available for
rectangular sections only.
Sides Different: Input a reinforcement pattern in which each one of the four sides
of a rectangular section has a certain number of bars and a certain bar size. Available
for rectangular sections only.
Irregular Pattern: Input a reinforcement pattern in such a way that bars of any
size can be placed anywhere within the column section.
Confinement: Input confinement-related data such as the capacity reduction factors
and the size of ties associated with the longitudinal bar size.
Design Criteria: Input parameters that govern the design of the section such as:
minimum and maximum reinforcement ratio, and minimum clear spacing.
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Slenderness
Design Column: Input data needed for slenderness related to the column being
considered.
Column Above/Below: Input data needed for slenderness related to the columns
above and below the design column.
X-Beams: Input data needed for slenderness related to beams perpendicular to the
x-axis framing into the design column.
Y-Beams: Input data needed for slenderness related to beams perpendicular to the
y-axis framing into the design column.
Factors: Input factors that affect slenderness calculations.

Loads
Factored: Input factored axial loads and moments. This command is available for
non-slender columns only.
Service: Input service-level (dead, live, and lateral) axial loads and moments about
the active axis. Moments are input at the top and at the bottom of the column. This
command must be used for slender columns.
Control Points: If chosen, the program will compute key points on the interaction
diagram. In addition, the splice regions are shown on the interaction diagram. This
option is available for short (non-slender) columns under the investigation option
only.
Axial Loads: Input a group of axial loads with an initial value, a final value, and
an increment. This command is available for uniaxial short (non-slender) columns
only.
Load Combinations: Input the load factors and combinations used to combine
the service loads.

Flip/Rotate Section
Flip an unsymmetrical section about an axis or rotate an irregular section.



PCACOL

Method of SolutionThe PCACOL Window 3-11

Solve Menu

The Solve menu contains commands used to perform the design or investigation,
trace through the design process, and send the output to a text file.

Execute
Executes the solver.

Design Trace
Toggles trace-through-a-design On and Off.

Results File
Toggles output-to-results-file On and Off.
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View Menu

The View menu commands used to customize the display screen to suit your viewing
needs, view the interaction diagram at a given angle, view the contour for a given
axial load, superimpose an interaction diagram or a contour from another run, and
view the results file.

Redraw
Redraws the displayed diagram or contour and clear any superimposed curves.

Information Bar
Shows or hides the Information bar.

Tool Bar
Shows or hides the Tool bar.

Status bar
Shows or hides the Status bar.

Grid
Shows or hides the grid.

Contour
View a contour of the failure surface sliced at a constant axial load.

Interaction
View an interaction diagram sliced at a constant (Mx, My) angle.

Superimpose
Superimpose a diagram from a previously saved run over the current diagram.

Results
View the results file after a successful run has been performed with the Solve |
Results File option ON.
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Help Menu

Contents and Index

Lists all the available help topics about the program.

Using Help

Provides help on using the Microsoft Windows help system.

About

Displays copyright information and the version number of the program.



Chapter 4
Operating the Program

This chapter is divided into sections that follow the order in which commands and
options appear in the program.

Creating a New Data File

When PCACOL is first loaded, the program is ready to obtain input for a new file. The
data will not have a filename associated with it, therefore, Untitled appears in the Title
bar.

• Select File | New. This clears the screen and returns to the default settings of the
program. If existing data have been changed prior to selecting the New command,
PCACOL asks if you want to save the data. At any time after starting a new file,
use the File | Save As command to give the file a name.
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Opening an Existing Data File

You can open PCACOL data files that were previously saved to disk. PCACOL reads
files that have been saved in binary format (with COL extension).

• Select File | Open. A dialog box appears.

• All files with the COL extension contained in the current drive and directory are
displayed in the File Name list box.

• To open a file that exists in another drive or directory, select the drive or directory
you want from the Drives drop-down list or the Directories list box respectively.

• From the File Name list box, select the file to be opened, or simply type its
name in the text box.

• Choose the OK button.
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Saving the Data

To save the data with the same filename:
At anytime while editing a data file that has previously been saved under a
filename, choose File | Save to save the changes under the same file name. Selecting
the File | Save command before giving the data file a name displays the Save As
dialog box.

To give the data a new or different filename:
• Select File | Save As. A dialog box appears.

• All files with COL extension contained in the current drive and directory are
displayed in the File Name list box.

• To save the file to a drive or directory other than the default, select a different
drive from the Drives drop-down list or a different directory from the Directories
list box.

• In the File Name text box, type a new filename. If no file extension is specified,
.COL will be appended to the specified filename.

 • Choose the OK button.
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Importing Data

Geometry, reinforcement or load data may be imported from a text file. The import file
must be saved in pure ASCII (text) format.

• Select File | Import. A dialog box appears.

• Select the type of data you want to import: Service Loads, Factored Loads,
Reinforcement or Geometry.

• Choose the OK button. The Open Import file box is displayed.

• All files with the TXT extension contained in the current drive and directory are
displayed in the File Name list box.

• To open a file that exists in another drive or directory, select the drive or directory
you want from the Drives drop-down list or the Directories list box respectively.

• From the File Name list box, select the file to be opened, or simply type its
name in the text box.

• Choose the OK button.

Operating the Program4-4
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Printing the Results

Once a successful run has been performed you may print the displayed diagram. Also,
if the Solve | Results File option was selected, you may print the results file. PCACOL
sends the printout to the active printer.

• Select File | Print. A dialog box appears.

• Check the applicable option(s): Screen and/or Results File.

• Choose the OK button. A message box appears informing you that the file is
being printed. Choose Cancel to terminate the print job.
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General Information

The General Information command allows you to define or change options that will
affect the rest of the input.

• Select Input | General Information. A dialog box appears.

• Enter the project, column, and engineer labels.

• Select the units of measure, English or Metric.

• Select the axis about which the column capacity is to be computed: X-axis, Y-
axis, or Biaxial.

• Select the design code to conform to: ACI 318-95 or CSA A23.3-94.

• Choose a run option: Investigation or Design.

• Specify whether slenderness effects are to be considered or not.

• Choose the OK button.
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Material Properties

• Select Input | Material Properties. A dialog box appears.

• Enter the concrete compressive strength, f’c.
The modulus of elasticity, Ec; the constant stress intensity at the maximum
usable strain used to calculate the force on concrete, fc; the factor used to
determine the depth of the stress block, Beta(1); and the maximum usable
strain at the extreme concrete compression fiber, are automatically computed
and displayed. Modify any of the values if different that computed.

• For the reinforcing steel, enter the yield strength, fy, the modulus of elasticity,
Es, and the rupture strain.

• Choose the OK button.
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Inputting for the Investigation Option:

• Select Input | Section | Rectangular. A dialog box appears.

• Enter the width and depth of the rectangular section. Note that width is measured
along the x-axis and depth is measured along the y-axis.

• Choose the OK button.

Inputting for the Design Option:

• Select Input | Section | Rectangular. A dialog box appears.

• Enter the starting and ending values for each dimension (width and depth) along
with an increment for each dimension. Note that the starting and ending values
may be the same (in which case the increment must be zero).

• Choose the OK button.

Operating the Program4-8

Section | Rectangular
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Inputting for the Investigation Option:

• Select Input | Section | Circular. A dialog box appears.

• Enter the diameter of the column section.

• Choose the OK button.

Inputting for the Design Option:

• Select Input | Section | Circular. A dialog box appears.

• Enter the starting and ending values the diameter along with an increment. Note
that the starting and ending values may be the same (in which case the increment
must be zero).

• Choose the OK button.

4-9Operating the Program

Section | Circular
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Reinforcement | All Sides Equal

The Input | Reinforcement | All Sides Equal command allows you to enter the total
number of bars in the column section. The program attempts to divide the bars equally
between the four sides of a rectangular layout then equally space them on each side.
Corner bars are associated with the top and bottom sides, and if the total number of bars
is not a multiple of four, the top and bottom sides get the extra bars. For a circular
layout, the program attempts to equally space the bars.

Inputting for the Investigation Option:

• Select Input | Reinforcement | All Sides Equal. A dialog box appears.

• Enter the total number of bars in the section (must be at least 4 and must be a
multiple of 2 for a rectangular layout).

• Select the bar size.

• Enter the clear cover and specify whether it is to the transverse (ties) or to the
longitudinal bars.

• Select a bar layout, Circular or Rectangular. The default is Circular for a circular
section and Rectangular for a rectangular section.

• Choose the OK button.
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Inputting for the Design Option:

• Select Input | Reinforcement | All Sides Equal. A dialog box appears.

• Enter the minimum and maximum total number of bars in the section (must be
at least 4 and must be a multiple of 4 for a rectangular layout).

• Select the minimum and maximum bar sizes along with the clear cover.

• Enter the clear cover and specify whether it is to the transverse (ties) or to the
longitudinal bars.

• Select a bar layout, Circular or Rectangular. The default is Circular for a circular
section and Rectangular for a rectangular section.
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Reinforcement | Equal Spacing

The Input | Reinforcement | Equal Spacing command allows you to enter the total
number of bars in the column section. The program attempts to place the bars equally
spaced on all four sides of a rectangular layout. Corner bars are associated with the top
and bottom sides and if the total number of bars is not a multiple of 4, the top and
bottom sides will get the extra bars.

Inputting for the Investigation Option:

• Select Input | Reinforcement | Equal Spacing. A dialog box appears.

• Enter the total number of bars in the section (must be at least 4 and a multiple of 2).

• Select the bar size.

• Enter the clear cover and specify whether it is to the transverse (ties) or to the
longitudinal bars.

• Choose the OK button.
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Inputting for the Design Option:

• Select Input | Reinforcement | Equal Spacing. A dialog box appears.

• Enter the minimum and maximum total number of bars in the section (must be
a multiple of 4).

• Select the minimum and maximum bar sizes.

• Enter the clear cover and specify whether it is to the transverse (ties) or to the
longitudinal bars.

• Choose the OK button.
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Reinforcement | Sides Different

Inputting for the Investigation Option:

• Select Input | Reinforcement | Sides Different. A dialog box appears.

• Enter the number of bars to be placed on each of the top, bottom, left and right
sides of the rectangular section. Note that corner bars are associated with the
top and bottom sides.

• Select the bar size and enter the clear cover for each of the top, bottom, left and
right sides of the section.

• Specify whether the clear cover entered is to the transverse (ties) or to the
longitudinal bars.

• Choose the OK button.
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Inputting for the Design Option:

 • Select Input | Reinforcement | Sides Different. A dialog box appears.

• In the Top and Bottom group, enter the minimum and maximum total number
of bars to be placed on the top and bottom sides, along with the bar size and the
clear cover. The number of bars must be greater than 4 and a multiple of 2.
Corner bars are associated with the top and bottom sides.

• Select the minimum and maximum bar size and enter the clear cover.

• Repeat the steps above for the Left and Right sides.

• Specify whether the clear cover entered is to the transverse (ties) or to the
longitudinal bars.

• Choose the OK button.
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Reinforcement | Irregular

The Input | Reinforcement | Irregular Pattern command allows you to specify any number
of bars (up to 500) to be placed anywhere within the column section. Each bar may have
any cross-sectional area. This command is available with the Investigation option only.

• Select Input | Reinforcement | Irregular Pattern. If you have the IRRCOL module
and the section is irregular, the IRRCOL window, where the section reinforcement
may be graphically input, is displayed. Otherwise, a dialog box appears.

• Enter the bar area, along with its x- and y-coordinates.

• Choose the Insert button. The data are added to the list box.

• Repeat the steps above for each entry.

• To edit an entry, select it from the list box, modify its values in the text boxes, and
choose the Modify button. To change the area for several bars at once, select those
bars from the list box, enter the new area in the Area text box, and choose Modify.

• To delete a bar entry, select it from the list box and choose the Delete button.

• Choose the OK button.
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Reinforcement | Design Criteria

• Select Input | Reinforcement | Design Criteria. A dialog box appears. This
command is available with the Design option only.

• Specify whether the column is to be considered Structural (default), Architectural,
or Other. Notice that the minimum and maximum reinforcement ratios change
depending on the selection.

• To modify the limiting reinforcement ratios, choose Other. Enter the minimum
and maximum reinforcement ratios in the corresponding text boxes.

• Enter the minimum clear bar spacing and the design-to-required ratio.

• Choose the OK button.
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Reinforcement | Confinement

• Select Input | Reinforcement | Confinement. A dialog box appears.

• Select the type of bar confinement: Tied (default), Spiral, or Other. The capacity
reduction factors change depending on the selection.

• To modify the capacity reduction factors, choose Other for confinement type.

For the ACI code:
Phi(a) is the reduction factor for pure axial compression
Phi(b) is the reduction factor flexure and axial tension
Phi(c) is the reduction factor for combined flexure and axial compression

For the CSA code:
Phi(a) is the reduction factor for pure axial compression
Phi(s) is the material resistance factor for steel
Phi(c) is the material resistance factor for concrete

• Specify the tie size associated with the particular longitudinal bar sizes. The
code requirements are used as defaults.

• Choose the OK button.
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Slenderness | Factors

• Select Input | Slenderness | Factors. A dialog box appears. Note: this command
is available for slender columns only.

• The default values, per the design code, for the stiffness reduction factor (used
to compute the moment magnification factors) and the cracked section
coefficients for beams and columns are displayed. To modify these values, select
the User-defined option and enter your values.

• Choose the OK button.
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Slenderness | Design Column

• Input | Slenderness | Design Column. A dialog box appears. The x-axis or y-
axis data groups may be disabled depending on the active run axis. Note: this
command is available for slender columns only.

• Enter the clear column height in the corresponding text box.

• Specify whether the column is braced against sidesway or not by selecting or
clearing the Braced Against Sidesway option.

• For an unbraced column, enter the ratio of the sum of the critical load of all
story columns to the critical load of the column under consideration, (Sum Pc)/Pc.
Also, enter the ratio of the sum of the factored axial load of all story columns to
the factored axial load of the column under consideration, (Sum Pu)/Pu.
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• In the Effective Length Factors group, specify whether the k factor(s) are to be
user-input or computed by the program, by selecting the corresponding option.

• If you chose Input k Factors, enter the effective length factors for braced and
sway conditions, Kb and Ks, respectively.

• Repeat the steps above for each active axis.

• Choose the OK button.
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Slenderness | Columns Above and Below

 • Input | Slenderness | Columns Above/Below. A dialog box appears. Note: this
command is available for slender columns only for which the Compute k Factors
option is selected in the Design Column dialog box.

• In the Column Above group, specify whether or not a column above the design
column exists, by selecting or clearing the No column specified option.

• If a column above exists; enter the center-to-center height, the width (along the x-
axis), the depth (along the y-axis), the concrete compressive strength, and the
concrete modulus of elasticity of the column above in the corresponding text boxes.
For circular sections, enter zero for the Depth and input the section diameter in the
Width box. If zero is entered for both Width and Depth, the dimensions of the
design column will be automatically used.

 • Repeat the same for the column below or, if the column above and the column
below are the same, choose the Copy to Column Below button.

 • Choose the OK button.
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Slenderness | X-Beams

• Input | Slenderness | X-Beams. A dialog box appears.  Beams defined using
this command span perpendicular to the x-axis. Note: this command is available
for slender columns only for which the Compute k Factors option is selected in
the Design Column dialog box and the run axis is biaxial or uniaxial x-axis.

• From the Beam Location group, choose the appropriate option. The data group
below updates depending on the selection.

• For the selected beam, specify whether or not a beam exists, by selecting or
clearing the No Beam Specified option.

• If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if
different than computed) of the beam.

• Repeat the steps above for the beams above right, below left, and below right.

• Choose the OK button.
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Slenderness | Y-Beams

• Select Input | Slenderness | Y-Beams. A dialog box appears. Beams defined
using this command span perpendicular to the y-axis. Note: this command is
available for slender columns only for which the Compute k Factors option is
selected in the Design Column dialog box and the run axis is biaxial or uniaxial
y-axis.

• From the Beam Location group, choose the appropriate option. The data group
below updates depending on the selection.

• For the selected beam, specify whether or not a beam exists, by selecting or
clearing the No Beam Specified option.

• If a beam exists; enter the center-to-center span length, width, depth, concrete
compressive strength, concrete modulus of elasticity, and moment of inertia (if
different than computed) of the beam.

• Repeat the steps above for the beams above right, below left, and below right.

• Choose the OK button.
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Loads | Factored

Whether designing or investigating a short (non-slender) column, factored loads
consisting of applied axial loads and moments about the active axis may be input.

• Select Input | Loads | Factored. A dialog box appears.

• Enter the factored axial load in the Load text box.

• Depending on the active axis, enter the factored moment about the x-axis, the
factored moment about the y-axis, or both.

• Choose the Insert button. The data are added to the  list box.

• Repeat the steps above for each factored load entry.

• To edit an entry, select it from the list box, modify its values in the text boxes,
and choose the Modify button.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose the OK button.
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Loads | Service

When designing or investigating a short or slender column, service level loads consisting
of dead, live, and lateral axial loads and moments at both column ends about the active
axis may be input. These loads are then factored and combined based on the load
combinations.

• Select Input | Loads | Service. A dialog box appears.

• For each of the load cases: dead, live and lateral, enter the axial load and the
applicable moment (about x or y) at the column top and bottom.

• Choose the Insert button. The data are added to the list box.

• Repeat the steps above for each entry.

• To edit an entry, select it from the list box, modify its values in the text boxes,
and choose the Modify button.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose the OK button.
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Load | Control Points

A non-slender column may be investigated without inputting any loads. The capacity
of the section is computed along with other important information. This command is
not available for slender columns or under the Design option.

• Select Input | Loads | Control Points.

In the output file, key points on the interaction diagram are listed. For each
point, the axial load and bending moment capacities, along with the
corresponding neutral axis depth, are listed.

For a biaxial run, these points are listed for bending about positive and negative
X and Y axes.

For a uniaxial runs, the bar-splice regions are indicated on the interaction diagram.



PCACOL

Method of Solution4-28 Operating the Program

Loads | Axial Loads

When investigating a short column (uniaxial runs only), grouped factored applied axial
loads may be input. The corresponding moment capacity for each load is computed and
output. This command is not available under the Design option, for biaxial runs, or if
the column is slender.

• Select Input | Loads | Axial Loads. A dialog box appears.

• To input a range of axial loads, enter the initial, final and increment values in
the corresponding text boxes. To input a discrete (single) axial load, enter its
value in the Initial text box, and enter zero in the Final and Increment text boxes.

• Choose the Insert button. The data are added to the list box.

• Repeat the steps above for each axial load entry you may have.

• To edit an entry, select it from the list box, modify its values in the text boxes,
and choose the Modify button.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose the OK button.
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Loads | Load Combinations

PCACOL allows you to specify up to eight load combinations. The service load input
under the load cases (dead, live and lateral) are combined based on these combinations.
A minimum of one combination must be input.

• Select Input | Loads | Load Combinations . A dialog box appears. For a new
file, the default combinations per the selected code are shown in the list box.

• To add a new combination, enter the load factors or multipliers for each load
case, Dead, Live and Lateral.

• Choose the Insert button. The data are added to the list box.

• Repeat the steps above for each load combination. Up to eight combinations
may be defined.

• To edit an entry, select it from the list box, modify its values in the text boxes,
and choose the Modify button.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose OK when done.
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Flipping / Rotating the Section

This command is available for Irregular sections and for sections with Sides Different
or Irregular reinforcement.

• Select Input | Flip/Rotate Section. A dialog box appears.

• Select one of the options: Flip section about x-axis, Flip section about y-axis, or
Rotate section.The last option is available for irregular sections only.

• If Rotate section is selected, enter the angle of rotation (clockwise is positive).

• Choose the OK button.
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Executing a Run

• Select Solve | Results File. This is an option that may be turned ON or OFF by
choosing it again. With this option ON, an output file will be created while the
program is solving. The output file is a text file that contains an echo of the
input along with slenderness calculation output, load combinations, and the
critical points on the interaction diagram.

• Select Solve | Design Trace (design option only). This is an option that may by
turned ON or OFF be choosing it again. With this option ON, if designing a
column section, the program will pause at each cross section and reinforcement
layout it tries, and display the cross section with its bars in the Information bar.

• Select Solve | Execute. If more data are needed to solve the problem, an error
box appears and you will be prompted for the required data. If all the needed
data are input, the solver portion of PCACOL will start executing. The Solving
box appears with a progress indicator. Click Cancel to terminate the solution
process.

After a successful run, the interaction diagram or the contour plot is displayed in
the Graphics area of the window.
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Viewing the Results

Once a successful run has been performed with the Execute | Results File option ON,
you may view the results file.

• Select View | Results . PCACOL executes the PCAVIEW program, an applet
that enables viewing of text-based files.

• Use the scroll bars or the cursor keys to navigate through the file.

• Select Exit to quit PCAVIEW and return to PCACOL.



PCACOL

Method of Solution

Changing the Startup Defaults

You can change some default settings that PCACOL uses when it is started or when the
File | New command is executed.

• Select Options | Startup Defaults. A dialog box appears.

• Enter the full path of the directory to which PCACOL defaults when opening a
data file.

• Select the system of units, design code, and rebar database to be used as defaults
whenever a new file is started.

• Enter the name of the program to be used by PCACOL when viewing results.
By default, PCACOL uses PCAVIEW.

• Enter the number of lines per page to be used in formatting the results file.

• Choose the Save button to save these options in the PCAPROGS.INI file.

Operating the Program 4-33



PCACOL

Method of Solution4-34 Operating the Program

Changing the Rebar Database

• Select Options | Rebar Database. A dialog box appears.

To select a different set:

• From the Bar Set drop-down list, select the set to be used.

• Choose the OK button.
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To create or modify a user-defined set:

• From the Bar Set drop-down list, select User-defined. The Add, Delete and
Modify buttons are enabled.

• To edit an entry, select it from the list box, modify its values, and choose the
Modify button.

• To delete an entry, select it from the list box and choose the Delete button.

• To add an entry, enter the bar size, diameter, area and unit weight in the
corresponding text box, and choose the Add button. The data are added to the
list box.

• A user-defined set may be saved to disk for use in other files. To do so, choose
the Save button after inputting the bars. To retrieve a saved set, choose the Read
button. Rebar database is saved to the PCACOL.BAR file.

• Choose the OK button.
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Superimposing Diagrams

After executing a run and  selecting the File | Save command, the program saves the
diagram data in a separate file that has the same filename as the input file, with an IAD
extension. This file may be later read by the program and two diagrams (of different
files) may be superimposed for the purpose of comparison. Note that the run option
(uniaxial or biaxial) of the two files must be the same

• Select View | Superimpose. The open dialog box appears.

• All files with the IAD extension contained in the current drive and directory are
displayed in the File Name list box. To open a file that exists in another drive or
directory, select the drive or directory you want from the Drives drop-down list
or the Directories list box respectively.

• From the File Name list box, select the file to be opened, or simply type its
name in the text box.

• Choose the OK button. If the data is successfully read, the diagram from the
IAD file (shown dotted) is superimposed over the currently displayed diagram.

• To clear any superimposed diagrams, select the View | Redraw command.
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Viewing the Diagram

For a uniaxial run, the program computes and displays the P-M interaction diagram.
For a biaxial run, the program computes the three-dimensional failure surface (P, Mx,
My). The failure surface can be viewed in one of two ways:

a) P-M interaction diagram (vertical slice at an angle measured from Mx)
b) Mx-My contour curve (horizontal slice at a constant axial load).

Whenever the mouse cursor moves over the Graph area, the axial load, moment,
and eccentricity are displayed in the Status bar.

Viewing the Interaction Diagram

• Select View | Interaction. A dialog box appears.

• Specify whether you want to enter an angle or the values of the moments that
produce a view angle by selecting either the Angle or Moments option, respectively.

• If the Angle option was selected, select an angle from the list, use the scroll bar
to pick an angle, or simply enter the value in the text box.

• If the Moments option was selected, enter the values of Mx and My which
produce a view angle. The value of that view angle is computed and shown in
the Angle text box.

• Choose the OK button.
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Viewing the Contour

• Select View | Contour. A dialog box appears.

• Select an axial load from the list, use the scroll bar to pick a load, or simply
enter the value in the text box.

• Choose the OK button.
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Example 1 - Design of a Short Column

Determine the size and reinforcement of a column section to carry the following
factored loads:

Pu = 1,700 kips, Mux = 1,900 ft-kips, Muy = 1,200 ft-kips

The column section is rectangular, limited in width to 32 in but the depth could be as
large as 48 in. The reinforcing bars are equally distributed on all four sides and the
reinforcement ratio should be limited to 3%. Use 6-ksi concrete and 60-ksi
reinforcing steel.

1. From the File menu, choose New. Any input data is cleared and the default values
are restored.

2. From the Input menu, choose General Information.

• Input the project header.

• Select English units and ACI 319-95 code.

• Select Biaxial for run axis, Design for run option and No for slenderness.

• Choose Ok.

3. From the Input menu, choose Material Properties.

• Input 6 for the concrete strength. Other properties are computed and will be
accepted.

• Choose Ok.

4. From the Input menu, choose Section | Rectangular.

• For the section Width, input 32, 32 and 0 under Start, End and Increment.

• For the section Depth, input 36, 48 and 2 under Start, End and Increment.

• Choose Ok.
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5. From the Input menu, choose Reinforcement | Equal Spacing.

• Input 20-#9 bars for minimum and 40-#11 bars for maximum.

• Input 1.5 in for the cover and select Transverse bars.

• Choose Ok.

6. From the Input menu, choose Reinforcement | Design Criteria.

• Under Column Type, select Other.

• Input 3 for Maximum Reinforcement Ratio.

• Choose Ok.

7. From the Input menu, choose Loads | Factored.

• Input 1700 , 1900  and 1200  for the Load, X-Moment and Y-Moment,
respectively.

• Choose Insert to add the entry to the list box.

• Choose Ok.

8. From the Solve menu, choose Execute.

• The solver of the program is started and, upon completion, displays the selected
section that passes the design (32x38 with 22-#11 bars).

• The Mx-My contour at zero-axial load is displayed in the Graphics area.

9. From the View menu, choose Interaction.

• The Angle list displays the Mx-My angle for the input moment(s). Choose 32
from the list.

• Choose Ok. The PM interaction diagram (at 32-deg Mx-My angle) is displayed
in the Graphics area. The load point is indicated on the diagram.
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10. From the View menu, choose Contour.

• The Design Axial Load list displays the value(s) of any input load(s). Choose
1700 from the list.

• Choose Ok. The Mx-My contour at P=1700 kips is displayed in the Graphics
area. The load point is indicated on the diagram.

11. From the View menu, choose Results.

• Page through the results file.

• Choose Exit to quit the PCAVIEW program and get back to PCACOL.

12. From the File menu, choose Print.

• Insure that both Screen and Results File are checked. Choose Ok.
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Example 2 - Capacity of a Braced Column

Check the capacity of an interior column, located on the third floor of a braced frame.
The frame has 5 bays (24 ft on centers) and 6 floors (14 ft floor-to-floor height).

All interior columns are 18x18 and all exterior columns are 16x16. All interior columns
of the third floor have 8-#10 bars with 1.5 in cover. All beams are 48x12 and support
a 6-in slab. The moment of inertia of the T-section is 13,823 in4. Use 4-ksi concrete
and 60-ksi steel for all beams and columns.

The service load values for the column under consideration are as follows:

Dead Live
P  230  173
Top Mx  2  108
Bottom Mx  2 -100

The column is to be checked for the following load combination:
U1 = 1.4 D + 1.7 L

1. From the File menu, choose New. Any input data is cleared and the default values
are restored.

2. From the Input menu, choose General Information.

• Input the project header.

• Select English units and ACI 319-95 code.

• Select About X for run axis, Investigation for run option and Yes for
slenderness.

• Choose Ok.
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3. From the Input menu, choose Material Properties.

• Input 4 for the concrete strength. Other properties are computed and will be
accepted.

• Choose Ok.

4. From the Input menu, choose Section | Rectangular.

• Input 18 and 18 for the section width and depth.

• Choose Ok.

5. From the Input menu, choose Reinforcement | Equal Spacing.

• Input 8-#10 bars and 1.5 in for the cover and select Transverse bars.

• Choose Ok.

6. From the Input menu, choose Slenderness | Design Column.

• Input 13 for the column clear height.

• Check the Braced against sidesway option and select Compute ‘k’ factors.

• Choose Ok.

7. From the Input menu, choose Slenderness | Columns Above/Below.

• Clear the No column specified option.

• Input 14 for the column height (center-to-center) and leave the other data as is.

• Choose Copy to Column Below.

• Choose Ok.
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8. From the Input menu, choose Slenderness | X-Beams.

• Choose Above Left.

• Clear the No beam specified option.

• Input 24 for the span (center-to-center).

• Input 48 and 12 for the width and depth, respectively.

• Input 13823 for the moment of inertia.

• Leave the other data as is.

• Choose Above Right and click on Copy From Beam Left.

• Choose Below Left and click on Copy From Beam Above.

• Choose Below Right and click on Copy From Beam Above.

• Choose Ok.

9. From the Input menu, choose Loads | Service.

• Input 230, 2.0 and 2.0 for the dead Load, X-Moment and Y-Moment,
respectively.

• Input 173, 108 and -100 for the live Load, X-Moment and Y-Moment,
respectively.

• Choose Insert to add the entry to the list box.

• Choose Ok.

10. From the Input menu, choose Loads | Load Combinations.

• If the list displays four combinations, select the last three and choose Delete.
and eave the other data as is. only need to consider the first combination
(1.4 Dead + 1.7 Live).

• Choose Ok.

11. From the Solve menu, choose Execute.

• The solver of the program is started and, upon completion, displays the
interaction diagram of the section with the load point plotted within the diagram.

5-13



PCACOL

Examples5-14

12. From the View menu, choose Results.

• Page through the results file.

• Choose Exit to quit the PCAVIEW program and get back to PCACOL.

13. From the File menu, choose Print.

• Insure that both Screen and Results File are checked. Choose Ok
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Example 3 - Capacity of a Sway Column

Check the capacity of an interior column, located on the third floor of a sway
(unbraced)frame. The frame has 5 bays (24 ft on centers) and 6 floors (14 ft floor
to-floor height).

All interior columns are 18x18 and all exterior columns are 16x16. All interior columns
of the third floor have 8-#10 bars with 1.5 in cover. All exterior columns of the third
floor have 8-#8 bars. All beams are 48x12 and support a 6-in slab. The moment of
inertia of the T-section is 13,823 in4. Use 4-ksi concrete and 60-ksi steel for all
beams and columns.

In addition to the gravity load analysis, a lateral load analysis due to wind was
performed. The service load values for the column under consideration are as
follows:

Dead Live Wind
P 230 173 6
Top Mx  2 108 84
Bottom Mx 2 -100 -70

The column is to be checked for the following load combinations:
U1 = 1.4 D + 1.7 L
U2 = 0.75 (1.4 D + 1.7 L + 1.7 W)
U3 = 0.9 D + 1.3 W

Based on preliminary computations, Pc for interior columns is 2,466 kips and Pc for
exterior columns is 1,120 kips. With 2 exterior columns and 4 interior columns,
SPc = 2x1,120 + 4 x 2,466 = 12,104 kips. For the column under consideration, the
ratio SPc/Pc = 12,104/2466 = 4.91.
Theoretically, the ratio ΣΣPu/Pu would be different for each combination. Since the
program allows for one ratio only, the most conservative one (the ratio due to the
second load combination) will be used. For combination U2, the total factored gravity
loads on the floor is ΣPu = 2,320 kips and the factored load on the column is Pu =
470 kips. For the column under consideration, the ratio ΣPu/Pu = 2,320/470 = 4.94.
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1. From the File menu, choose New. Any input data is cleared and the default values
are restored.

2. From the Input menu, choose General Information.

• Input the project header.

• Select English units and ACI 319-95 code.

• Select About X for run axis, Investigation for run option and Yes for
slenderness.

• Choose Ok.

3. From the Input menu, choose Material Properties.

• Input 4 for the concrete strength. Other properties are computed and will be
accepted.

• Choose Ok.

4. From the Input menu, choose Section | Rectangular.

• Input 18 and 18 for the section width and depth.

• Choose Ok.

5. From the Input menu, choose Reinforcement | Equal Spacing.

• Input 8-#10 bars and 1.5 in for the cover and select Transverse bars.

• Choose Ok.

6. From the Input menu, choose Slenderness | Design Column.

• Input 13 for the column clear height.

• Clear the Braced against sidesway option and input 4.91 and 4.94 for the
Sum Pc/Pc and Sum Pu/Pu, respectively.

• Select Compute ‘k’ factors

• Choose Ok.
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7. From the Input menu, choose Slenderness | Columns Above/Below.

• Clear the No column specified option.

• Input 14 for the column height (center-to-center) and  leave the other data as is.

• Choose Copy to Column Below.

• Choose Ok.

8. From the Input menu, choose Slenderness | X-Beams.

• Choose Above Left.

• Clear the No beam specified option.

• Input 24 for the span (center-to-center).

• Input 48 and 12 for the width and depth, respectively.

• Input 13823 for the moment of inertia.

• Leave the other data as is.

• Choose Above Right and click on Copy From Beam Left.

• Choose Below Left and click on Copy From Beam Above.

• Choose Below Right and click on Copy From Beam Above.

• Choose Ok.
9. From the Input menu, choose Loads | Service.

• Input 230, 2.0 and 2.0 for the dead Load, X-Moment and Y-Moment,
respectively.

• Input 173, 108 and -100 for the live Load, X-Moment and Y-Moment,
respectively.

• Input 6, 84 and -70 for the lateral Load, X-Moment and Y-Moment,
respectively.

• Choose Insert to add the entry to the list box.

• Choose Ok.
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10. From the Input menu, choose Loads | Load Combinations.

• If the list displays four combinations, select the third combination and choose
Delete.

• Choose Ok.

11. From the Solve menu, choose Execute.

• The solver of the program is started and, upon completion, displays the
interaction diagram of the section with the load points plotted
within the diagram. Note that point 2 falls just outside the interaction diagram
indicating inadequate capacity of this section.

12. From the View menu, choose Results.

• Page through the results file.

• Choose Exit to quit the PCAVIEW program and get back to PCACOL.

13. From the File menu, choose Print.

• Insure that both Screen and Results File are checked. Choose Ok.
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Chapter 6
The IRRCOL Module

IRRCOL is an add-on module to the PCACOL program. It enables the user to inves-
tigate irregularly shaped reinforced concrete sections subject to a combination of
loadings. IRRCOL considers a polygonal section reinforced with bars located at any
location. The section may contain one opening. In addition, IRRCOL allows easy
modification of a circular section by converting it into an approximate polygon.

IRRCOL is accessed from within PCACOL. Once PCACOL is started, you can acti-
vate IRRCOL by selecting the Section | Irregular command from the Input menu.
This starts IRRCOL, minimizes and locks the PCACOL window and maximizes the
IRRCOL window. The section geometry may then be defined by drawing it on the
screen or by inputting the coordinates of the polygon nodes. Once the section defini-
tion is complete, return to PCACOL by selecting Save and Exit from the Main menu.

Once the irregular section is defined, its reinforcement is input using IRRCOL
as well. This is done by selecting the Reinforcement | Irregular command from the
Input menu of PCACOL. The section reinforcement may also be defined graphically.
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IRRCOL

Main Menu

Drawing Area
Set the limits for the drawing area and control the grid and snap settings.

Save and Exit
Accept the input and/or modifications made in IRRCOL and return to PCACOL.

Exit without Saving
Discard the input and/or modifications made in IRRCOL and return to PCACOL.
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IRRCOL

Edit Menu

Section
Toggles the input/editing session to the section.

Opening
Toggles the input/editing session to the section opening.

Reinforcement
Toggles the input/editing session to the section reinforcement.

Add
Switches to the Add mode to graphically insert section or opening nodes or
reinforcing bars.

Delete
Switches to the Delete mode to graphically delete section or opening nodes or
reinforcing bars.

Move
Switches to the Move mode to graphically move section or opening nodes or
reinforcing bars.

Modify
Allows manual editing of the section or opening node coordinates or the reinforc-
ing bar area and coordinates.
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IRRCOL

View Menu

Zoom
Magnifies or reduces the graphical image.

Pan
Translates or moves the graphical image.

Redraw
Redraws the displayed section and resets the Zoom and Pan actions.

Grid
Shows or hides the grid.

Snap
Toggles the Snap On and Off. With the Snap On, the cursor snaps (sticks) to
exact locations.

Labels
Shows or hides the internal numbering of section (or opening) nodes and bars.

Status bar
Shows or hides the Status bar.
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IRRCOL

Help Menu

Index
Lists all the available help topics about the program.

About
Displays copyright information and the version number of the program.
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IRRCOL

Defining the Drawing Area

• Select Main | Drawing Area. A dialog box appears. This step is not needed the
first time IRRCOL is started using PCACOL’s Section | Irregular command. The
box is automatically displayed.

• Input the limits (minimum and maximum) of the area within which the section
is to be drawn in both directions.

• Input the interval (step) for the grid system. The grid is used as a guideline when
drawing.

• Select or clear the Show Grid option to show or hide the grid.

• Input the interval (step) for the snap. The snap settings may be different than the
grid settings and may be different in each direction (x and y).

• Select or clear the Snap On option to activate or disable the Snap.

• Choose the OK button.
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IRRCOL

Graphical Editing of the Section or Opening

In IRRCOL, the section (or opening) must be a closed polygon. It is defined by
inputting the nodes at each corner or vertex of the polygon. No two segments (sides)
may overlap or cross and no two nodes may coincide. An opening must lie com-
pletely within the section.
The coordinates that correspond to the cursor location are always displayed in the
Status bar. To force the cursor to “stick” to exact locations, turn the Snap option On.
The program will snap to locations whose coordinates are multiples of the snap steps.

To add section or opening nodes:

• Switch the input session to Section (or Opening) by selecting Edit | Section ( or
Edit | Opening).

• Switch the input mode to Add by selecting Edit | Add.

• If you are editing a section (or opening), you must first click on an existing node.
Once this is done, you can insert subsequent nodes.

• Adding a node is done by moving the cursor to a desired location within the Graphics
area and clicking the left-mouse button.

• After inserting a node, a line extending from the last added node follows the
cursor. Click at another location to insert subsequent nodes. A line connecting the
two nodes is drawn.

• To end the drawing, click the right-mouse button or press the ESC key. The first
and last nodes are connected to close the section. Also note that while in the Add
mode, moving the cursor outside the Graphics area ends the drawing.
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IRRCOL

To delete section or opening nodes:

• Switch the input session to Section (or Opening) by selecting Edit | Section ( or
Edit | Opening).

• Switch the input mode to Delete by selecting Edit | Delete.

• Marquee select the node (or nodes) to be deleted. This is done by moving the
cursor to one location, pressing the left-mouse button and while holding the button
down, moving to another location. While moving, a dotted rectangle (called the
marquee) is drawn. Releasing the left-mouse button end the marquee. All nodes
that are enclosed with the marquee are deleted and the section (or opening) is
redrawn.To cancel a marquee action while holding down the left-mouse button,
press the ESC key or click the right-mouse button. Also, leaving the Graphics area
cancels the marquee operation.

To move section or opening nodes:

• Switch the input session to Section (or Opening) by selecting Edit | Section ( or
Edit | Opening).

• Switch the input mode to Move by selecting Edit | Move.

• Place the cursor over the node to be moved then press and hold the left-mouse
button. As long as the button is held down, moving the cursor moves the selected
node to the cursor location. Once the node is at the new desired location, release
the mouse button. To cancel a move action while holding down the left-mouse
button, press the ESC key or click the right-mouse button. Also, leaving the Graphics
area cancels the move operation.
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IRRCOL

Graphical Editing of the Reinforcement

In IRRCOL, the reinforcing bars may be located anywhere. The only restriction
imposed in the program is that no two bars may overlap. The coordinates that corre-
spond to the cursor location are always displayed in the Status bar. To force the
cursor to “stick” to exact locations, turn the Snap option On. The program will snap
to locations whose coordinates are multiples of the snap steps. While in the Rein-
forcement session, you cannot switch to the Section or Opening sessions without
returning to PCACOL. Therefore, the Edit | Reinforcement command will have a
check mark to its left. You use the command to specify the bar size or area and the
number of bars to be added.

To add one single bar at a time:

• Switch the input mode to Add by selecting Edit | Add.

• Select Reinforcement from the Edit menu. A dialog box appears.

• In the Number of bars box, input 1.

• Choose the Size option and select the size of the bar or choose the Area option and
input the bar area in the edit box.

• Choose the OK button.

• In the Graphics area, point to the desired location and click. A bar is inserted.

• Repeat the step above to insert more bars.
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IRRCOL

To generate multiple bars:

• Switch the input mode to Add by selecting Edit | Add. The command must have a
check mark left of it.

• Select Reinforcement from the Edit menu. A dialog box appears.

• Input the number of bars to be generated (should be greater than 1).

• Choose the Size option and select the size of the bar or choose the Area option and
input the bar area in the edit box.

• Choose the OK button.

• In the Graphics area, click at a location (let us call it point A), move the cursor to
another location and click (let us call it Point B). The specified number of equally-
spaced bars are added, along the line connecting the points A and B.
For subsequent generations, point B becomes A and you only need to click at the
second point (B) to generate more bars.

• To end the multiple bar generation or move to another location (without adding
bars), click the right-mouse button or press the ESC key. Also note that while in
the multiple bar generation of the Add mode, moving the cursor outside the
Graphics area aborts the generation.

6-10



The IRRCOL Module

IRRCOL
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To delete bars:

• Switch the input mode to Delete by selecting Edit | Delete.

• Marquee select the bar(s) to be deleted. This is done by moving the cursor to one
location, pressing the left-mouse button and while holding the button down,
moving to another location. While moving, a dotted rectangle (called the marquee)
is drawn. Releasing the left-mouse button end the marquee. All bars that are
enclosed with the marquee are deleted. To cancel a marquee action while holding
down the left-mouse button, press the ESC key or click the right-mouse button.
Also, leaving the Graphics area cancels the marquee operation.

To move a bar:

• Switch the input mode to Move by selecting Edit | Move.

• Place the cursor over the bar to be moved then press and hold the left-mouse
button. As long as the button is held down, moving the cursor moves the selected
bar with it. Once the bar is at the new desired location, release the mouse button.
To cancel a move action while holding down the left-mouse button, press the ESC
key or click the right-mouse button. Also, leaving the Graphics area cancels the
move operation.
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Manual Editing of the Section or Opening

• Switch the input session to Section (or Opening) by selecting Edit | Section ( or
Edit | Opening).

• Select Edit | Modify. A dialog box appears. If you have already defined a section
(or opening), the coordinates of its nodes are shown in the list.

• To add a node, enter its x and y coordinates and choose the Insert button. The entry
is inserted in the list box following the selected entry.

• To edit an entry, select it from the list box, modify its values in the text boxes, and
choose the Modify button.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose the OK button.
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IRRCOL

Manual Editing of the Reinforcement

• Select Edit | Modify. A dialog box appears.

• To add a bar, enter its area, x-coordinate and y-coordinate and choose the Insert
button. The entry is inserted in the list box following the selected entry.

• To edit an entry, select it from the list box, modify its values in the text boxes, and
choose the Modify button. You can change the area of a group of bars by selecting
them from the list, enter the new area and choose Modify.

• To delete an entry, choose it from the list box and choose the Delete button.

• Choose the OK button.
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Zooming and Panning the Image

Zooming is the enlargement or reduction of the graphical image. Panning is the
translation or movement of the image.

Zooming:

• Select View | Zoom.

• To enlarge the view (zoom-in): using the left-mouse button, click anywhere within
the Graphics area. Click again for further magnification.

• To reduce the view (zoom-out): using the right-mouse button, click anywhere within
the Graphics area. Click again for further reduction.

• To reset the Zoom and return to the default, select View | Redraw.

Panning:

• Select View | Pan.

• Place the cursor over the Graphics area. Press the left-mouse button and, while still
holding the button, move the cursor in the direction you wish to pan. A line show-
ing the amount and direction of panning is drawn.

• Release the mouse button. The view is panned and the image is redrawn.

• To reset the Pan and return to the default, select View | Redraw.

Keyboard shortcuts:

The following keyboard assignments are always active:

Key combination Action

Ctrl + Page Up Zoom-in

Ctrl + Page Down Zoom-out

Ctrl + Cursor key Pan

Enter Reset zoom/pan (Redraw)
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Example 4 - Capacity of an Irregular Section

This example uses the IRRCOL add-on module.

Obtain the interaction diagram of a T-shaped section which contains a rectangular
opening. The capacity is to be computed about the x-axis. The section is reinforced
with 19-#8 bars, spaced 6 in. apart. The distance between the center of each edge
bar to the face of the section is 3 in. Use 6-ksi concrete and 60-ksi reinforcing
steel.

Note: when instructed to move to a location (15, 25), move the cursor until the
cells in the Status bar show “x=15” and “y=25”.

1. From the File menu, choose New. Any input data is cleared and the default
values are restored.

2. From the Input menu, choose General Information.

• Select English units and ACI 319-95 code.

• Select About X for run axis, Investigation for run option and No
for slenderness.

• Choose Ok.

3. From the Input menu, choose Material Properties.

• Input 6 for the concrete strength. Other properties are computed and will be
accepted.

• Choose Ok.

4. From the Input menu, choose Section | Irregular. The IRRCOL module is
loaded, its window occupies the desktop, and the Drawing Area box appears.

• Input –3 and –3 for the minimum X and Y, respectively.

• Input 45 and 45 for the maximum X and Y, respectively.
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• Input 3 and 3 for X and Y grid step, respectively and check the Show Grid
option.

• Input 3 and 3 for X and Y snap step, respectively and check the Snap On
option.

• Choose Ok.

5. The default input session is Section and the default input mode is Add (the Edit
| Section and Edit | Add options are checked).

• In the Graphics area, move the cursor to the location (6, 0) and click the left
mouse button. A node is inserted.

• Move to (24, 0) and click the left mouse button.

• Move to (24, 24) and click the left mouse button.

• Move to (30, 24) and click the left mouse button.

• Move to (30, 36) and click the left mouse button.

• Move to (0, 36) and click the left mouse button.

• Move to (0, 24) and click the left mouse button.

• Move to (6, 24) and click the left mouse button.

• Click the right-mouse button to end drawing the section.

6. To define the opening nodes, switch the input session to Opening by selecting
Edit | Opening. The input mode should still be Add (the Edit | Opening and
Edit | Add options are now checked).

• In the Graphics area, move the cursor to the location (12, 6) and click the left
mouse button. A node is inserted.

• Move to (18, 6) and click the left mouse button.

• Move to (18, 24) and click the left mouse button.

• Move to (12, 24) and click the left mouse button.

• Click the right-mouse button to end drawing the opening.
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7. From the Main menu, choose Save and Exit. You are returned to PCACOL
and the section is shown in the Information bar.

8. From the Input menu, choose Reinforcement | Irregular. The IRRCOL
module is loaded, its window occupies the desktop.

9. The default input session is Reinforcement and the default input mode is Add
(the Edit | Reinforcement and Edit | Add options are checked).

10. Define some bars using multiple bar generation:

• From the Edit menu, choose Reinforcement. Input 5 for the Number of
bars and select #8 from the Size list. Choose Ok.

• Move the cursor to the location (3, 33) and click the left mouse button.

• Move to (27, 33) and click the left mouse button. Five equally-spaced bars
are generated between the two locations.

• Click the right-mouse button to end.

• Move the cursor to the location (9, 27) and click the left mouse button.

• Move to (9, 3) and click the left mouse button. Five equally-spaced bars are
generated between the two locations.

• Click the right-mouse button to end.

• Move the cursor to the location (21, 27) and click the left mouse button.

• Move to (21, 3) and click the left mouse button. Five equally-spaced bars are
generated between the two locations.

• Click the right-mouse button to end.
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11. Define the remaining bars using single bar placement:

• From the Edit menu, choose Reinforcement. Input 1 for the Number of
bars and select #8 from the Size list. Choose Ok.

• Move the cursor to the location (3, 27) and click the left mouse button. A bar
is inserted.

• Move to (15, 27) and click the left mouse button. Another bar is inserted.

• Move to (27, 27) and click the left mouse button. Another bar is inserted.

• Move to (15, 3) and click the left mouse button. Another bar is inserted.

12. From the Main menu, choose Save and Exit. You are returned to PCACOL
and the section is shown in the Information bar.

13. From the Input menu, choose Loads | Control Points.

14. From the Solve menu, choose Execute.

• The solver of the program is started and, upon completion, displays the
interaction diagram of the section.

15. From the View menu, choose Results.

• Page through the results file.

• Choose Exit to quit the PCAVIEW program and get back to PCACOL.

16. From the File menu, choose Print

• Insure that both Screen and Results File are checked. Choose Ok.
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